
Writing a letter with 
Microsoft Word

Equipment needed: Computer (desktop or laptop) running 
Microsoft Word 2010 or Microsoft Word 2007 (see Introduction).

Skills needed: Ability to use a computer keyboard and mouse (or 
trackball). 

People love to receive letters. Not bills or bank statements, but genuine corre-
spondence from friends and family. In this chapter, I’ll show you how you can use 
Microsoft Word to write a personal letter that will delight one of your friends. It’s 
up to you who you send it to.

Although this is a simple project, it’s a great illustration of the power of word pro-
cessing. Unlike a typewritten or handwritten letter, you can easily change your 
mind about what you want to say, how you want to say it and how you want your 
letter to look. You can insert new words, sentences or paragraphs and get rid of 
any that you’re not so keen on when you reread the letter. 

You can also add some polish, with Word’s sophisticated presentation functions. 
In this chapter, we’ll explore how you can modify the text style and alignment, but 
the next two chapters in Part I will build on these skills to show how you can cre-
ate professional looking publications.
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Starting Word

There are several ways to start the Word program, depending on which version of 
Windows you are using and how your software has been set up.

First, you need to fi nd the Start button. This isn’t the button that you use to switch 
on your computer or the one on your keyboard. It’s on the screen, in the bottom 
left corner. In older versions of Windows, the button is coloured green and says 
‘Start’ on it, but in Windows Vista and Windows 7, the button is round and has a 
Windows icon on it.

Place your mouse pointer over the Start button and click it (by pressing the left 
mouse button). This will open a ‘menu’ of programs. Look to see if Word is among 
them, and if it is then simply position your mouse pointer over that item in the list 
and then click it (press the left mouse button). 

If you can’t see Word on the menu, you need to position your cursor on All Pro-
grams at the bottom of the menu, and then click it. A menu of all the programs on 
your computer will open. Find the folder for Microsoft Offi ce (you might need to 
use the scrollbar if you are using Windows 7 or Vista). When you click the folder, 
it will open so you can see the Word entry. Click on that, and Word will start load-
ing. It sounds complicated, but it only takes about four seconds once you know 
how to do it.

If you’re nifty with a keyboard and are using Windows Vista or Windows 7, 
there’s a quicker way. Find the Start key on your keyboard (see Figure 0.1 in 
Introduction); it is usually on the bottom row and has the same picture of the 
Windows ‘fl ag’ as the onscreen Start button. Press the Start key, type ‘Word’ 
and then press Enter, and you should see Word fi re up.

These are just a couple of many ways you can start Word. You might have a Word 
icon on your desktop that you can double-click, for example, or you might have 
Word pinned to your taskbar in Windows 7. Feel free to experiment to fi nd the 
quickest way to start Word on your PC. The above approach will work for every-
one, but it won’t necessarily be the quickest way to do it.
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Saving your work

Word automatically opens a new blank document when you start the program. So 
when Word opens, you’ll be faced with a sight that will either inspire you with its 
endless possibilities or strike fear into your heart: a blank page.

Before you let rip with your creativity, though, I recommend that you save your work. 
If you have used any other programs, you might have saved fi les before. Whenever 
you create a new fi le or make changes to an existing fi le, you need to save it  on 
your computer’s hard disk. It is important to save whatever fi le you’re working on 
regularly, because anything in the computer’s memory (including your current work) 
is wiped if there’s a power cut or your PC freezes (which happens rarely with mod-
ern PCs). Anything that you have already saved on the hard disk will be safe, though. 

Saving your fi le also means that you can come back to it again another day to re-
read it, work on it or even modify it for another purpose.

Saving is not the same as backing up. When you save something, you store 
it in a fi le on your computer so it’s still available even after you switch the 
machine off and on again. When you back up, you make a spare copy of that 
fi le, just in case the computer it’s stored on breaks down.

Given that you haven’t typed anything yet, it might seem an odd time for me to 
mention this now. After all, you’re about to save an empty fi le. It can be a bit fi ddly 
saving your work for the fi rst time, though, so it’s best to cover this fi rst. If you save 
the fi le now, you can then easily keep the fi le updated as you’re writing, without 
interrupting your fl ow. The easier it is to save your fi le as you write, the more likely 
you are to do it and the less likely you are to lose any fi nely crafted sentences – or 
worse still, fi nely crafted paragraphs or pages!

The menus used for saving fi les are slightly different in Offi ce 2010 and Offi ce 
2007, but not so different that there’s likely to be any confusion. In Offi ce 2010, you 
should see a blue File tab in the top left corner of the screen, as shown in Figure 1.1.

When you click the File tab, you’re taken to what Microsoft grandly calls the 
‘backstage area’. The idea is that this is where you go when you want to save, print 
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or otherwise manage your document. Anything that isn’t to do with the content of 
your document and its appearance can be found backstage.

Save

Close

Help

Undo

Redo

Home tab Scrollbar

File tab

Cursor

Figure 1.1 

When you click the File tab to go backstage, you’ll be shown some information about 
your document, including how many words and pages long it is (none, so far), and 
how long you’ve been editing it. On the left, you’ll see Save as one of the options. 
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In Offi ce 2007, there is a round Offi ce button in the top left corner of the screen, 
as shown in Figure 1.2.

Save

Close

Help

Undo

Redo

Home tab

Office button

Figure 1.2 

This is where all the fi le management and printing functions are kept, and Save is 
one of the options.

Whichever version of Word you are using, the process is the same after this. When 
you click the Save button, you see a fi le browser, like the one in Figure 1.3.

In Figure 1.3, I’ve clicked in the bottom right of the window and dragged it to 
make it bigger, so you can more clearly see what’s going on in the screenshot. I 
recommend you save your work in your Documents folder. Click Documents in 
the left pane and fi nd a suitable folder in which to store your work on the right. If 
you have lots of folders, you might need to use the scrollbar. If you can’t fi nd a 
suitable folder, you can create a new one. Put your mouse pointer in the right 
pane and right-click it (press the right mouse button). The right-click menu opens, 
shown in Figure 1.3, from which you can select New and then select Folder. The 
new folder will appear in the right-hand pane, and you can type in its name and 
press the Enter key.
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Left pane Right pane Scrollbar

Documents

File name box Save button

Right-click menu

Figure 1.3 

The Enter key is sometimes called the Return key. It’s on the right hand side 
of the main part of the keyboard and is often oversized so you can easily hit 
it (see Figure 0.1 in Introduction). It usually has an arrow on it that goes 
down a bit and then points to the left, echoing the motion of the carriage 
return on a typewriter. The Enter key is used in word processing to mark the 
end of a paragraph. It’s also used more generally to tell the computer you’ve 
fi nished entering information or to confi rm an action, as in this case.
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Once you’ve found your folder, you need to give your fi le a name. This is how 
Windows and all your programs will refer to this fi le in future. A good fi le name 
will help you to uniquely identify your letter without having to open it, so don’t 
just pick a name like ‘Letter’ because you’ll have lots of letters in future. Choose 
something more meaningful like ‘James letter about Spain’. Don’t worry about the 
.docx at the end of the fi le name. This is a technical marker that helps Windows 
work out what program created a particular fi le. 

Click in the File Name box and you’ll see the default name is selected. You can 
now type something new over the top of it.

When you’re happy with your fi le name and where you’re saving it, click the Save 
button.

Now you’ve saved your fi le, you can update what’s in it rapidly. To save your document 
at any time, simply click on the disk icon in the top left corner (see Figures 1.1 and 1.2) 
and your work will be sent to the hard disk for safekeeping. You can also use a keyboard 
shortcut: fi nd the Control key, which is marked CTRL. There are two of these, one at the 
bottom left and one at the bottom right of the main part of the keyboard (see Figure 0.1 
in Introduction for an illustration). While holding down one of the Control keys, tap the 
S key, and the current version of your fi le will be saved. After a while, you might fi nd 
you do this almost as a refl ex action the moment you type something you want to keep.

This is the fi rst of many actions you’ll learn using the Control key, but in 
future, they’ll be written as CTRL+S, or whatever key you need to tap while 
holding down the Control key.

It’s important to remember to save your work regularly; information is only stored 
on the disk when you tell Word to do so. 

Actually, that’s not quite true. If you’re unlucky enough to suffer a power cut, you 
might be lucky enough that Word can still rescue your work. Word automatically saves 
whatever you’re working on regularly, and Offi ce 2010 will even temporarily keep 
copies of fi les you haven’t saved (you’ll fi nd these in your recent fi les in the backstage 
area). But I don’t recommend counting on luck when there’s a simple keyboard short-
cut that can save you any wasted effort. Remember to CTRL+S, and life will be good.
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Writing your letter

Now that you’ve got the housekeeping out of the way, it’s time to start writing your 
letter. Click on the blank page, underneath the menu bar, and you will see a small 
vertical line blinking on and off in the top left corner of the page. This blinking line 
is your cursor (see Figure 1.1). It shows you where your words will appear when 
you type them. Type a few characters, and the cursor will move along with each 
one, so that new characters are added at the end of what you’ve written so far. 

If you have ever used a typewriter, you might be waiting for a bell to ring to warn you 
to do a carriage return as you reach the end of the line. With a word processor, you 
can just keep typing. Word will automatically move you to the next line when you run 
out of space. It will also move any half-written words to the next line to avoid having 
to use hyphens. If you look up from the keyboard and see that the cursor has vanished 
with half your word, don’t panic. Check the start of the next line fi rst.

When you reach the end of a paragraph, press the Enter key on your keyboard. 
Word will start you on a new line, but will also put a bit of empty space between 
the paragraphs, so that it’s easier for people to see where each paragraph begins 
and ends. If you’re a word processing veteran, you might have to break an old 
habit here: in some programs you press Enter twice to put a blank line between 
the paragraphs, but you don’t need to do that in Word.

It doesn’t matter if you make a mistake – you’ll learn how to fi x it later. For now, 
just familiarise yourself with typing in text, so that you’ve got something to play 
with when you work on editing text later. You can safely ignore any green or red 
squiggly lines that appear under your text too. They highlight where Word thinks 
you’ve made a mistake, but you’ll learn how to get rid of those later. (You’ll also 
fi nd out that Word isn’t quite as clever as it thinks it is.)

If you want to save a different copy of your document, so you can have various 
versions of it or so you can retrace your steps later if you might want to go back 
to an earlier version, choose Save As from the backstage area or Offi ce menu and 
give the document a new fi le name. A new fi le will be created with your chosen 
fi lename, leaving your last saved version with the old fi lename intact. When you 
do an ordinary save from then on, your changes will be saved in this new copy.
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To get used to the basics, I suggest you focus on the body of your letter for now. 
I’ll show you how to add your address on the right later. If you’re short on ideas 
for what to say, think about what you did at the weekend, what you’re reading at 
the moment, what the family is up to and where you’re going on holiday. You 
could cheat and just type a load of mumbo jumbo (I won’t know about it!) but 
since I’m going to show you how to print your letter it would be nice if you had 
something to post at the end of this project.

If you struggle to read the text on screen, you can enlarge your view of the page. 
This won’t affect the size of the text when it’s printed out, it will just magnify it on 
the screen. To do this, click on the plus sign in the bottom right corner to zoom in 
(shown in Figure 1.4). You can click the minus to zoom out again.

Zoom out Zoom in

Figure 1.4

If you are struggling to do something and this book can’t help, why not try 
searching Word’s built in help function? You’ll fi nd a question mark in a cir-
cle in the top right corner: click this or tap the F1 key to get started.

Making changes to what you’ve written

Oh no! I didn’t mean to type that! What now?

There’s an old joke about computers providing countless new opportunities… to 
make mistakes. But the best thing about computers is that they make them so easy 
to fi x. If you’ve got the correcting fl uid poised over the monitor, back away now!
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If you need to go back and change something you wrote earlier, you fi rst need to 
position your cursor in the place where you want to make changes. The simplest 
way to do this (particularly if you spot the error quickly) is to use the cursor keys 
to move through your document. The cursor keys have arrows on them pointing 
up, down, left and right and are usually grouped together somewhere on the right 
of the keyboard (see Figure 0.1 in Introduction). 

When you press the left cursor key, the cursor will move back through your text, 
one character at a time. If you press the up cursor key, the cursor will go up a line. 
The right and down cursor keys will take you back in those directions. The cursor 
can’t go outside of the text, so you can’t position the cursor beyond the end of 
what you’ve typed. If you go up or down into a shorter line, the cursor will jump 
to where the text fi nishes on that line.

If you have a long document it can take almost as long to shuffl e through the text 
as it did to type it, so there are a number of keys you can use to move around the 
document more quickly, as shown in Table 1.1. (Refer to Figure 0.1 for an indica-
tion of where you can fi nd these keys.)

Table 1.1 Keyboard shortcuts for navigating your Word document
Key(s) Effect on cursor
Home Moves to the start of the current line
End Moves to the end of the current line
Page Up Moves up a page through the document (you’ll need 

to have a document that’s more than one page long 
to see this in action)

Page Down Moves down a page through the document
CTRL+left Moves one word to the left
CTRL+right Moves one word to the right
CTRL+up Moves to the start of the next paragraph up
CTRL+down Moves to the start of the next paragraph down
CTRL+end Moves to the end of the document
CTRL+home Moves to the start of the document
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You don’t need to memorise all the shortcut key combinations. They are a bit 
complex and, to be honest, you can get by without them a lot of the time. For a 
short letter like this, you won’t see much benefi t from them. But as you fi nd your-
self working on more complex projects and longer documents, you’ll fi nd these 
shortcuts invaluable. They save so much time. As you use them, they start to 
become second nature too. I almost forgot about being able to move through 
words using the Control key, until I noticed I was doing it while writing this chap-
ter! I recommend you play with these combinations in your letter now, just to 
familiarise yourself with them. Once you know what’s possible, you can always 
look up a particular combination later when you need it. 

There is another way to position the cursor, which some people fi nd easier. That’s 
to use the mouse. Place your mouse pointer where you’d like your cursor to go 
(such as in the middle of a paragraph) and then click it. Your cursor will jump 
there instantly. If you need to move between pages in your document (or even just 
scroll further down the page), put your mouse pointer over the scrollbar at the 
right of the page (see Figure 1.1), click your left mouse button and hold it down 
while you roll the mouse up and down the desk. You can also use the scroll wheel 
on your mouse to move up and down the page.

The mouse can save time if you want to move your cursor into the middle of a 
sentence a few paragraphs or even many pages back. But some people fi nd it too 
fi ddly for more minor changes. If you only want to edit the line above, or the 
paragraph above, it’s usually quicker to use the keyboard than to switch to the 
mouse and move the cursor around.

Ultimately, it doesn’t matter how you move your cursor. Most people use a com-
bination of keyboard and mouse depending on what they are doing. You can 
strike the balance that works best for you, even if it means always using the mouse 

Function keys such as Home are often shared with the numeric keypad. If 
you see numbers coming up on screen when you press them, tap the Num 
Lock key on your keyboard. That will switch the number keypad to the right 
mode for you to be able to use the functions in Table 1.1. If you want to 
revert to using the numbers on the keypad again, press Num Lock once 
more. Num Lock is at the top left corner of the numeric keypad.
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or always using the keyboard. By experimenting with your letter to see how easy 
you fi nd the different techniques, you can make an informed choice.

Once you’ve positioned your cursor where you want it, you can add new text at 
that point in the document. It doesn’t matter whether you want to add a sentence 
or a paragraph, whatever you type will be inserted wherever your cursor is in the 
document. When you want to pick up at the end again, position your cursor at the 
end of your letter so you can carry on typing there.

Deleting text

Some things are better left unsaid. As well as adding new text to your document, 
you will doubtless want to take things out from time to time. There are three dif-
ferent ways to delete text.

 1. The Backspace key is found at the top right of the main part of your keyboard, 
and has a long, left-pointing arrow on it (see Figure 0.1). This is one of the 
larger keys on the keyboard, refl ecting how often everybody needs to use it! 
When you press it, the character to the left of the cursor is exterminated and 
the cursor moves to the left. This is the key most people think of as the ‘delete 
key’ because it’s used most often. But it should not be confused with…

 2. …the (real) Delete key. This is often found on the numeric keypad, and will 
say ‘Delete’ on it (or ‘Del’ if it’s being less formal). Sometimes there are two 
delete keys (see Figure 0.1). When you press this key, the character to the right 
of the cursor is deleted and the cursor stays where it is. It looks as if the cursor 
is swallowing the text to its right. Remember to try tapping Num Lock if it’s not 
working for you.

 3. You can also select text (see later in this chapter) and continue typing over it. 
The text you select will then be replaced with whatever you type next.

Moving text around

So far, we’ve made some fairly minor changes to our document, deleting some 
words or sentences and adding a few others. But what if you want to completely 
change the order of your content? If you’re working on longer pieces, you might 
fi nd that you need to experiment with the order of the sections until you fi nd the 
way they fl ow best. Word processing makes it easy to move things around.
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Selecting text with the mouse

First of all, let’s look at how you can move a whole paragraph. Imagine your letter 
is four paragraphs long, and you’ve decided that you’d like to move your second 
paragraph to the end. 

The fi rst step is to select the piece of text you’d like to move. This is a bit awkward, 
so it might take a couple of goes to get the hang of it. First, move your mouse 
pointer to the start of the paragraph. It doesn’t matter if your cursor is in the mar-
gin, or whether it looks like an arrow or an ‘I’. As long as you are aligned with the 
correct row of text, you’ll be fi ne. Then you need to click your left mouse button 
and keep it held down. Move the mouse down the screen, and you’ll see your text 
becomes highlighted in blue, as shown in Figure 1.5. Once you reach the end of 
the paragraph and everything you need is highlighted in blue, you can let go of 
the mouse button. When you let go, the text will stay selected. 

Be careful not to type anything now, otherwise it will replace the text you’ve 
selected. If you do brush the keyboard, refer to the section on reversing mistakes 
later in this chapter.

Selecting text with mouse clicks

If you fi nd that moving the mouse around is, well, moving you to tears, there are 
shortcuts you can use to select text. As you know, when you move your mouse 
pointer over a word and press the left mouse button, your cursor moves to that 
place in the word. But if you click multiple times or in different ways, you can get 
different results, as shown in Table 1.2.

Don’t forget to keep saving your work. You’ll be free to experiment if you 
know you’ve got a good copy stored safely. If you want to save a messed up 
version, use Save As to store a different version and keep your clean version 
safe. If you really mess it up and need to go back to an old saved version, 
skip to the end of the chapter for advice on closing Word; after you have 
closed Word without saving your messed up version, you can reopen your 
clean version and pick it up from there.
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Figure 1.5

Table 1.2 Mouse shortcuts for text selection
Shortcut What is selected
Press the mouse button twice in quick 
succession

A word

Press the mouse button three times in 
quick succession

A paragraph

Hold down the Control key and press 
the mouse button once

A sentence

Hold down the Shift key and press the 
mouse button once

All text between the cursor and 
the mouse pointer

Click the mouse button in the margin The line of text is selected
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These shortcuts are great time savers, but don’t let them stop you from experi-
menting with text selection. Sometimes you’ll need to be more precise, and will 
need to select text the long way.

Selecting text using the keyboard

If you fi nd it hard to use the mouse, you can use the keyboard to select text. You 
use the same controls you used to move the cursor around (see Table 1.1), but 
hold down the Shift key at the same time. If you want to select the character to the 
left of the cursor, hold down the Shift key and press the left cursor key. If you want 
to select the word to the left of the cursor, hold down Shift and Control and press 
left, and that word will be selected and highlighted in blue. If you want to select 
the line you’re at the end of, hold down Shift and tap the Home key.

Sometimes this technique seems to select odd chunks of text. If you’re in the 
middle of a line and you press Shift and up, it will select all the text to the left of 
the cursor on the current line, and all the text to the right of the cursor on the line 
above, and will then move the cursor to the line above. Figure 1.6 shows what 
happens if I position my cursor before the word ‘zebra’ and then use Shift and up 
to select text.

The way to understand what you can select with each combination of keys, is to 
experiment with using the left and right arrows to move through your document. 
What happens when your cursor reaches the end of a line of text? It goes to the 
start of the next line. What happens when you reach the left hand side of a line of 
text? The cursor goes to the right hand side of the line above.

Figure 1.6

Text selection using the keyboard does the same thing. Although you tap the up 
key and see it move instantly, imagine the cursor is going back along the line 
you’re on, selecting characters as it goes. When it reaches the left-hand side, it 
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goes to the right edge of the line above, and keeps moving left, selecting charac-
ters as it goes, until it comes to the spot above where it started.

As with moving the cursor around, you should experiment to see whether you 
prefer the mouse or the keyboard. Many people fi nd the keyboard quicker, but it 
won’t make much difference if you use the mouse instead.

Moving your selected text

Now you’ve got your text selected, move your mouse pointer into the blue high-
lighted area, click your left mouse button and hold it down. Now when you move 
your mouse, you’ll see a dotted cursor move through your text one word at a time 
(see Figure 1.5, at the end of the letter). In the bottom left, Word is asking ‘Move 
to where?’

You can put your dotted cursor anywhere you like at the start or end of a para-
graph, or in the middle of one.

When you release your mouse button, your selected text and the cursor will be 
moved to where the dotted cursor is. The blue highlighting that showed the text 
was selected will also disappear.

You’re not limited to selecting paragraphs. You can select sentences, words or 
even letters and move them around using this technique. It’s a good idea to prac-
tise selecting and moving text, because you also need to select text when you 
want to change its appearance, as you’ll soon see. 

Using cut, copy and paste

Now that you know how to select a piece of text, you can start to do things to it. 
Across the top of the window, you’ll see what Microsoft calls the ‘ribbon’. This 
spreads out all the controls at your command, and can seem a bit daunting. When 
you don’t understand what everything does, it’s a bit like looking at the control 
panel of a space shuttle. Don’t be overwhelmed, though. You can safely ignore a 
lot of the controls (for now, at least) and the ribbon does make it easier to fi nd 
what you’re looking for without getting tied in knots.
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The fi rst set of controls you should explore is the clipboard. You’ll fi nd this on the 
left-hand side, as shown in Figure 1.7.

Paste

Cut

Copy

Open advanced clipboard sidebar

Format painter

Figure 1.7 

If you can’t see the clipboard on the left of the ribbon, click the Home tab next 
to the File tab (in Offi ce 2010) or near to the Offi ce button (in Offi ce 2007). 
You should fi nd that the clipboard controls are now shown on the left.

The clipboard is used for temporarily storing something. Have you ever read a 
phone number and then concentrated on remembering it until you can write it 
down? The clipboard works a bit like that. You can put text on your clipboard, and 
the computer will ‘remember’ it for you until you’ve found somewhere else to put 
it. This is done using a process called ‘cut and paste’, and it’s another way you can 
move text around. It’s particularly useful if you want to move text a long way, and 
is often used to move text between different documents or even different 
applications.

To cut and paste text, you do the following:

 1. Select the text you want to cut, using either the mouse or keyboard.

 2. Click the scissors icon on the ribbon by putting your mouse icon over it and 
pressing the left mouse button. The text will be cut out of your document.
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 3. Move your cursor to where you would like your text to go.

 4. Click the Paste icon on the ribbon. The text on the clipboard will be added 
back in to your document where your cursor is.

You can paste the same text as many times as you want. You can also leave the 
original text in place by fi rst clicking the copy icon, the one that shows two pages 
instead of the scissors icon (see Figure 1.7). That will put a copy of the text onto 
the clipboard without removing it from your document.

When you paste, Word will usually insert the last thing you put on the clipboard. 
For simplicity’s sake, it’s a good idea to work with only one thing on the clipboard 
at a time, and not to leave things there for too long. 

When you cut a piece of text, be very careful to paste it as soon as possible, don’t 
forget it’s on the clipboard and don’t cut anything else before you paste; if you do 
that, you’ll lose the fi rst piece of text you cut. (You wouldn’t be the fi rst!)

If you are doing something more complex, you can keep a lot of different text 
snippets on the clipboard. If you click in the bottom right of the clipboard area to 
expand the clipboard, you’ll open an advanced clipboard sidebar on the left that 
can hold multiple clippings at once (see Figure 1.8). When you copy or cut a 
piece of text, your cuttings are added to this clipboard. You can click one of those 
snippets to paste it into the document wherever the cursor is. (To close the 
advanced clipboard, click the X in the top right corner of the clipboard sidebar.)

There are keyboard shortcuts you can use to save time when cutting and past-
ing. CTRL+X will cut (the X looks like scissors), using CTRL+C will copy, and 
using CTRL+V will paste. Those three keys are all together on the keyboard. 
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Figure 1.8 

Changing the appearance of your letter

It would be a boring world if all our documents looked the same, so Word gives 
you a lot of control over how individual words or parts of your document are for-
matted. Now that you’ve learned to select text, you should fi nd it easy to format 
its appearance.

Look at the Font area on the ribbon, shown in Figure 1.9. I’ve created a document 
here to show some of the different text effects that are possible.

To apply the different styles, you just select your text (as you did before you moved 
it earlier) and then click the relevant button on the ribbon. If you want to make an 
important word bold, for example, select that word and then click the ‘B’ icon on 
the ribbon. If italic is more your style, select your text and then click the ‘I’ icon. 
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Bold

Italic

Underline

Strikethrough

Increase font size

Decrease font size

Change case

Remove formatting

Colour text

Text effects

Figure 1.9

Some of the formatting options are used rarely. Unless you’re writing a dissertation 
about Einstein (E=mc2?), you probably won’t need the superscript formatting, for 
example. The strikethrough format is more or less redundant because you can just 
delete any mistakes rather than crossing them out, so it’s usually used to jokingly 
pretend you wrote something else fi rst then changed your mind. So if you can’t 
see a use for a particular formatting option or don’t really understand what it’s for, 
it doesn’t matter.

06_711965-ch01.indd   3606_711965-ch01.indd   36 9/13/10   2:48 PM9/13/10   2:48 PM



Writing a letter with Microsoft Word

37

You can also use the formatting tools like switches to turn on bold, italic or 
other styles before you type your text. Just click the same button to switch 
them off again.

You’ll notice that some of the formatting options have a little triangle pointing 
downwards beside them. When you click one of these, you’ll see more options 
open up. When you click the one next to the ‘Aa’ icon, for example, you can 
choose to change to upper case, lower case, sentence case or all words initial-
capitalised. The underlining options enable you to choose different types of under-
lining, such as double, dotted or wiggly lines. You can also change the colour of 
the text or its background by opening the options beside the appropriate icons. 
Use the highlighter tool to change the text background.

In Offi ce 2010, Microsoft has introduced a new option for you to create fancy text 
effects. This enables you to add refl ections, glow effects and shadows to your 
words, and includes a number of shiny and hollow looking text styles. Like deco-
rated cakes, effects like these are best consumed in small chunks on special occa-
sions. They’re too rich for everyday use.

Leave your mouse pointer over a button on the ribbon for a couple of sec-
onds and a box will temporarily pop up to tell you what it does.

Although the Fonts section of the ribbon includes lots of formatting options, strictly 
speaking a font is just the design of lettering you are using. In Figure 1.9, I have 
used a couple of different fonts. If you compare the Times New Roman Text with 
the Arial text, you will probably notice lots of subtle differences. For example, the 
Times font has tiny strokes (called serifs) at the ends of letters like the h and the s; 
the Arial font doesn’t. (Text without serifs is described as sans serif.) A font com-
prises a complete set of symbols in the same style, including upper and lower case 
letters, numbers and punctuation. 

You can change the font by clicking the triangle to the right of the font name and 
then choosing one from the list. You see a sneak preview of it before you apply it 
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too, so you can avoid picking anything that won’t look right. You can change the 
font size by typing a new value into the font size box, or by selecting the size from 
the options. You’ll fi nd your PC has lots of different fonts installed, but not all of 
them are easy to read.

When you select text, you will see the ghost of a tiny control panel materi-
alise above the selected text. If you put your mouse over it, the controls will 
appear properly and provide quick access to the most frequently used for-
matting controls. The control panel disappears if you ignore it.

Copying text formatting

I decided to personalise my letter in Figure 1.5 by using a font that looks like 
handwriting for the greeting and my name at the end. The Script MT Bold font has 
far neater handwriting than I do, so I used it to write ‘Dear Fred’ at the start.

When I got to the end of my letter, I could have gone through the same formatting 
steps as I did for the greeting, picking a new font, size and colour. But it’s boring 
to do the same things over again. Luckily, it’s possible to copy the formatting from 
one piece of text and apply it to another piece.

In the clipboard section of the ribbon (refer to Figure 1.7), there is a tool called the 
format painter, which looks like a paintbrush. To use it, you:

 1. Select the text you want to copy formatting from.

 2. Click the format painter button.

 3. Select the text you want to apply the formatting to.

 4. Watch your text transform to the new format.

There is also a keyboard shortcut: you can use CTRL+Shift+C to copy formatting 
from selected text, and CTRL+Shift+V to apply it to selected text.
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Keeping your text readable

Before too long, it will be obvious that you can create some truly eye-achingly 
ugly documents with Word. It’s easy to end up with something that looks like a 
teenager’s scrapbook, with 50 different colours, wiggly lines everywhere, odd 
capitalisation, rainbow colourings around letters and fonts so ornate that it would 
take the nation’s best cryptographers a good week to work out who fancies who.

The secret of good-looking documents is not so much what you put in, as what 
you leave out. It’s good practice to limit the number of different text styles you use. 
The number you can get away with will depend on the length and structure of 
your document, but you should think carefully before having more than three dif-
ferent styles on the same page. Use italics or bold for occasional emphasis, but if 
you use them for more than a few words at a stretch, the text becomes tiring to 
read. Large tracts in capital letters are hard to read, too (which is why lawyers love 
them for small print).

There is an art to picking a good font. Don’t be afraid to use boring fonts like Calibri 
(the default font), Times New Roman (the default font before Offi ce 2007) or Arial (a 
clean font for reading on-screen). These are much easier to read than fonts that 
mimic handwriting or have special effects. Try to match the font to its size, too: Arial 
Black is good for headlines but can be hard to read in the body of your text. Times 
New Roman can look a bit weedy as a headline but works great in your body text.

Fonts are measured in point sizes. A good size for normal copy is 11-12 pt, and 
headlines can be 20-36 pt. If your correspondent has poor eyesight, there’s no 
reason why you shouldn’t use a larger font, though. The font size options go up to 
72 point, which is pretty massive. You can type in values greater than that if you 
want, but by that point you’re making giant labels rather than writing letters.

If you want to format your whole document at once, use CTRL+A. That will 
select all the text in the document. Then you can apply the same formatting 
to everything.
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Clearing formatting and undoing mistakes

If you make a mess of the formatting, you can always use the Eraser icon in the top 
right of the Font section, which will remove the formatting but leave your text intact. 

There is also an Undo function, which you will learn to love. After you have done 
something you’re not happy with – or Word has automatically done something for 
you – you can use the Undo function to reverse that action. The Undo button 
looks like an anticlockwise arrow and is at the top left of the screen, as shown on 
Figure 1.1 (Offi ce 2010) and Figure 1.2 (Offi ce 2007). There is also a keyboard 
shortcut, which is CTRL+Z. Word will remember a sequence of actions, so you 
can repeatedly undo to go back a number of steps. If you go a step too far, there 
is a Redo function, a clockwise arrow beside the Undo button, which will redo 
something you’ve undone – or undo the undo, if you like! This doesn’t just work 
for formatting; if you manage to delete all your text off screen (surprisingly easy to 
do), Undo simply conjures it up again. Phew! That’s a relief. You can start breath-
ing again now.

Most designers are agreed that there’s nothing funny about the Comic Sans 
font. It was originally designed to be used in comic strip speech bubbles, but 
it can now be seen on all kinds of products and publications. There’s even a 
website that campaigns to stop its inappropriate use (at www.bancomicsans.
com). If you want your documents to have an air of professionalism, avoid 
Comic Sans.

Now you know that you can fi x anything that goes wrong, feel free to experi-
ment. Explore all the different ways you can jazz up your document, if only 
to get it out of your system.

Adding your address to your letter

Now you’ve mastered the formatting controls, it should be a doddle to add your 
address in the top-right corner of your letter. Move your cursor to the top of your 
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letter and start to type your address above your greeting. If you press Enter when 
you get to the end of each line, Word will think you’ve fi nished a paragraph and 
will add a gap between each line of your address. That makes the address look too 
spaced out. (Why not give it a go and see?) The solution is to use what is called a 
‘soft return’. This is a special way of telling Word you’ve fi nished a line, so it 
doesn’t think you’ve fi nished the whole paragraph. To create a soft return, hold 
down the Shift key when you press Enter.

Don’t start using the space bar to shunt the address to the right of the page. There’s 
a much more elegant solution. On the ribbon, you’ll fi nd a collection of controls 
you can use to change the way a paragraph appears on the page. Figure 1.10 
shows these, together with an explanation of what each of them does.

Bulleted list

Numbered list Decrease indent

Increase indent

Left alignment

Centre

Right alignment

Justified

Line spacing

Figure 1.10

To move your address to the right of the page, you just select it (remember you can 
just click it three times) and then click the right alignment button on the ribbon. 
You can select more than one paragraph at a time and apply paragraph formatting 
options to all of them, so you could right–align your address and the date in one go.

You might want to spend some time playing with the other formatting options, just 
to see what they do. The options are:

• Bulleted list: this moves the paragraph in from the left and puts a bullet in 
the space created at the start of the paragraph to draw attention to it. It’s best 
applied to a group of paragraphs together, like this bulleted list of paragraph 
formatting options.
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• Numbered list: this moves the paragraph in from the left and puts a number 
in the space created at the start of the paragraph. Paragraphs are numbered in 
order, and this is best used for paragraphs where the order or the number of 
paragraphs is part of what you want to say. 

• Left alignment: this formats text so it has a straight margin on the left, and 
ragged text on the right. This is what people use most of the time and I’ve used 
it in my document in Figure 1.9.

• Right alignment: this formats text so that it has a straight margin on the right 
and is ragged on the left. This would normally be used for an address in the 
top right of a letter.

• Justifi ed text: this formats text so that it has a straight margin on both the left 
and the right and the text is spaced out in between. It’s used for most of the 
text in this book.

• Centre: this formats text so it runs down the middle of the page, with ragged 
margins on both the left and the right. This can be used to centre a title on the 
page. It’s hard to read if applied to large blocks of text.

• Line spacing: this changes the spacing between lines in a paragraph and can 
be used to add or remove the space before a paragraph.

• Increase or decrease indent: to draw attention to a paragraph you can indent 
it, which moves the paragraph in from the left. 

We’ll come back to some of these controls in later projects.

Checking your spelling

Before you send your letter, you can run it through Word’s spellchecker. It can’t 
always tell if you’ve put words in the wrong order, or used the wrong word (such 
as ‘that’ instead of ‘than’) but it can pick up any words that aren’t in the dictionary. 
It has a go at fi xing grammar too, although that tends to be more hit and miss. 
Word is a bit like the pupil who shouts out all the answers in class despite only 
getting about half of them right.

You probably have some red and green squiggly lines underneath words in your 
letter. A red line means the word isn’t in Word’s dictionary; a green line means 
Word thinks the grammar might be broken.
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To check your spelling, you need to use a different ribbon. The ribbon is organised 
a bit like a fi ling cabinet. Imagine that all the controls for reviewing your text are 
on one tabbed divider, all the controls for page layout are on another, and both 
are fi led in the cabinet. Whenever you click a particular tab, you lift out that set 
of controls and move it to the front. So far, you’ve used the File tab (in Offi ce 
2010) and everything else you’ve needed has been on the Home ribbon. Now 
click the Review tab on the ribbon, and you’ll see the controls you need for spell-
checking come to the front.

You might have noticed that Word sometimes automatically corrects your 
spelling as you type. Type ‘wrod’ and see what happens! If it does this and 
you don’t want it to, press CTRL+Z to undo immediately afterwards.

Try clicking the different tabs to see what’s behind them, but don’t worry if 
you don’t understand the new controls you see. We’ll come to the important 
ones later. If you get lost, click the Home tab.

George Bernard Shaw is credited with saying that the US and UK are two nations 
divided by a common language, and this is never truer than when you’re trying to 
spellcheck something. If you spellcheck a UK document with the US dictionary, 
you’ll get all kinds of false alarms and might miss some genuine errors too. The 
fi rst thing you need to do, then, is to set the dictionary language. In Offi ce 2010 
(shown in Figure 1.11), fi nd the Language part of the Review ribbon, click the 
Language button and select Set Proofi ng Language. In Offi ce 2007, fi nd the Proof-
ing part of the Review ribbon and click Set Language. Your current language is 
highlighted at the top of the list, together with other languages you’ve already 
used so you can fi nd them quickly. You can scroll to fi nd the language you need 
and double–click it to set it.

To check the spelling of the whole document, click the Spelling & Grammar but-
ton on the Review ribbon (shown in Figure 1.11).
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Spelling & Grammar button

Check grammar

Figure 1.11

A new window will open. In the top box, it will show you an excerpt from your 
text, with a questionable section shown in red (for spelling alerts) or green (for 
grammar queries). In the second box, it will show you Word’s suggestions for how 
to fi x the error. Your options for spelling are:

• Ignore Once: click this button if you’re satisfi ed you’re right and Word is 
wrong but you want it to tell you if it spots something similar later on. Use this 
if you could easily slip and make an error that looks like this, even though it’s 
correct this time. If you were writing a story about Shep the dog rounding up 
sheep, you’d probably Ignore Once when it fl agged up the dog’s name, so you 
could check you haven’t mis-spelled ‘sheep’ anywhere. 
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• Ignore All: click this button if you’re right and that’s fi nal. Use this for names 
of people or companies, so you don’t get alerted to every mention.

• Add to Dictionary: if you click this, Word will add your questionable word 
to its dictionary, so it will always know it’s correct on all documents you 
create. This is a good idea for names of people in your family. Try to avoid 
adding something that you might accidentally type when you meant to write 
something else.

• Change: when you click this, the coloured text in the top box will be replaced 
with the highlighted suggestion in the bottom box. If there are multiple 
suggestions, click the correct one fi rst.

• Change All: this will change all instances of the text in this document.

• Autocorrect: if you make this particular mistake often, click this button and 
Word will automatically fi x it for you as you type. Make sure that it is an 
unambiguous typing error. Don’t use Autocorrect to always change ‘nappy’ to 
‘happy’, because you might want to type ‘nappy’ in future.

For grammar errors, your options are:

• Ignore Once: this works the same way as the spelling check, as above.

• Ignore Rule: this will stop Word alerting you to similar problems in future. 
Word’s sense of grammar is a bit Victorian and not consistent with an informal 
letter style, so I often tell it to ignore a rule when it fl ags up sentence fragments 
that make sense in today’s English.

• Next Sentence: this jumps the grammar check ahead to the next sentence.

• Change: this works the same as the spelling check, as above.

• Explain: in this fun feature, Word will tell you why it thinks the grammar is 
wrong. The rules are pretty sound, but sometimes Word can’t identify when a 
rule is being broken. The most important thing is that it looks and sounds okay 
to you.

• Check grammar tickbox (also shown on Figure 1.11): If you uncheck this box, 
Word will concentrate on the spelling and ignore the grammar. Play with the 
grammar checker to see if you fi nd it useful, but don’t be afraid to turn it off if 
your writing style generates too many false alarms.
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If Word has found a mistake but doesn’t know how to fi x it, you can also click the 
text in the document and edit it there. Afterwards, click the Resume button in the 
spell check window to pick up where you left off.

As you are writing your letter, you can also right-click on any words or 
phrases with squiggles underneath them. A new menu will open, from which 
you can choose a suggestion (at the top), or choose to ignore once or 
throughout.

Now Word has set me straight on the spelling of onomatopoeia, I won’t have to 
ask Fred after all.

If you fi nd all that red and green underlining distracting (it’s a bit like being back 
at school), then you can switch it off. In Offi ce 2010, click the File tab and then 
click Options on the left. In Offi ce 2007, click the Offi ce button and then click 
Word Options in the bottom right. Once you’ve found the Options, click Proofi ng 
on the left to see the Proofi ng options shown in Figure 1.12. To get rid of the 
squiggles, untick the boxes beside Check spelling as you type and Mark grammar 
errors as you type.

To stop Word autocorrecting what you type, go into the Proofi ng options, and 
then click the button for AutoCorrect Options. Untick the box beside ‘Replace text 
as you type’.

You can also add your own replacements to the AutoCorrect dictionary in the 
Proofi ng options. This is a handy way to create short ways to type long words. 
For example, I could set it so that whenever I type ‘msox’ it replaces it with 
‘Microsoft Offi ce’. Take care that the short form you use isn’t a real word.

If you’re ever lost for words, there is also a thesaurus on the Review tab (why is 
there only one word for thesaurus?). Click its button on the ribbon and a Research 
panel opens on the right where you can enter your word and search, as shown in 
Figure 1.11. This Research sidebar also enables you to search the Encarta 
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dictionary and to translate your letter into a number of languages. (The translation 
is provided in your web browser, so you’ll need to select it, copy it and paste it 
back into Word.) Computer translations are a bit ropey but this can still be a useful 
tool if your correspondent doesn’t have a full command of English. I’d send them 
the English version too, though. To use the dictionary or translation service, select 
it in the pulldown menu at the top of the Research sidebar.

Turn on/off squiggles

Figure 1.12

Printing your letter

Once you’re happy with your letter, it’s time to print it out. The way this works is 
slightly different in Offi ce 2010 and Offi ce 2007.

In Offi ce 2010, you click the File tab and then click Print. On the right is a pre-
view of your document, to allow you to see what it will look like on the printed 
page. On the left, all your options are laid out, as shown in Figure 1.13.
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Usually, the default printer options will be fi ne, but you can choose different print-
ers (if you’re living in multi-printer luxury), and can choose which pages of your 
letter you want to print if you don’t want the whole thing. If that’s the case, you 
specify a page range using a dash to separate pages (eg 5-7) or you can list the 
pages you want and separate them with commas (eg 1,3,5,7). If you want multiple 
copies of your letter, you can specify that too. When you’re ready, click the Print 
button in the top-left corner, shown on Figure 1.13.

Print button

Figure 1.13

In Offi ce 2007, things look a bit different. Click the round Offi ce button in the 
top-left corner of the screen (see Figure 1.2) and then click Print on the menu. Your 
print options are similar to Offi ce 2010 but look like Figure 1.14. If you want to 
preview your document fi rst, click the Offi ce button, then place the mouse over 
Print, and click Print Preview on the right when it appears.
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Figure 1.14

When you’re happy, click OK, and your letter will print. Now, only one question 
remains: is there time to catch the post?

Finishing your Word session

When you’ve fi nished with Word for the day, click the Close icon in the top right of 
its window (shown on Figures 1.1 and 1.2). If you haven’t saved your work before 
quitting, Word will try to save you from yourself by reminding you. Think carefully 
before deciding whether to save the fi le. You may not want to save it because you 
haven’t made any signifi cant changes to it, or because by saving it you would be 
overwriting a good version of the fi le with one you’d rather discard.

To close your fi le without closing Word, click the File tab (Offi ce 2010) or Offi ce 
button (Offi ce 2007) and then click Close.

If you want to edit your fi le again later, you can double-click on the fi lename or 
icon in Windows and the computer will start Word and open that fi le for editing. 
You can also open Word as you did at the start of this project, and then click the 
File tab or Offi ce button, choose Open, and then fi nd the right fi le.

When the fi le fi rst opens, you might see it in a special preview mode that enables 
you to quickly read through it. To get out of that, click the Close button at the top 
right of the screen.
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Word makes it easy to fi nd recent documents. In Offi ce 2010, there is a Recent 
option when you go backstage. In Offi ce 2007, recent documents are listed when 
you click the Offi ce button. In either case, click the name of a recent fi le and it 
will load so you can work on it.

What else can you do?

Congratulations on fi nishing your fi rst project with Word! Here are some of the 
other ways you can use your new skills:

• Write formal correspondence. In this chapter we’ve covered informal letters, 
but you can also use Word to manage your letters to the bank or doctor, for 
example. You can print two copies of the same letter, one for the bank/doctor 
and one for your records. You can edit the letter to create modifi ed versions. 
You can use the same letter, with a new date and some alterations to the 
details, for regular prescription requests. The possibilities are endless.

• Create and print your CV, and make sure there are no typos in it!

• Write a diary. You can use Word to record your daily life for future generations 
or just for your own interest. If you’re worried about people prying, see Chapter 
5 for advice on encrypting your fi le.

• Write concrete poetry, where the layout and fonts help to convey the meaning. 
Or keep it simple and write straight poetry or song lyrics. 

• Write a book. Although we’ve only created a short letter here, Word can 
handle long and complex documents. You can even get your book published 
by uploading a Word document to sites like www.lulu.com.

• Print out some words in light grey text, so that younger family members can 
practise writing by tracing the words.

• Print your French homework double-spaced, so that you can write the 
translation in the gaps. (Use the paragraph formatting options to change the 
spacing between lines in a paragraph.)

• Type out your recipes to stick on the kitchen wall. You could even laminate 
them at your local printshop, to make them splash-proof.

• Create a checklist of everything you usually take on holiday. Every time you 
have to pack, you can print it out and cross things off as they go into the case.
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Summary

• There are lots of different ways to start Word, but you can always 
fi nd it by going through the Start menu.

• You should save your work before you start, and keep saving regularly.

• Your cursor shows you where any new characters or edits will appear.

• You can reposition your cursor using the keyboard or mouse, so that you 
can go back and change what you’ve written, or delete something.

• You can select text using the keyboard or mouse. Once selected, 
you can delete it, move it or format it.

• The ribbon lays out the controls in Word. You click the tabs on the 
top to bring different sets of controls to the front. 

• Cut and paste enables you to copy or move text around your docu-
ment, between documents or even between different programs.

• To change the formatting or alignment of your text, select it and 
then click the appropriate formatting option on the Home ribbon.

• To reverse the last thing you did, use the Undo button.

• Word’s built in spelling and grammar checker can help weed out 
errors, but it’s not perfect. You can override it any time you want.

• You can print your entire letter or choose specifi c pages.

• Close Word using the X in the top-right corner. 

• You can open your fi les to work on them again by double-clicking 
them in Windows, or using the File tab or Offi ce button to fi nd 
recent fi les and Open others.
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Answers

Q1 – a, b and d Q2 – a, b, c and d Q3 – b and c Q4 – c Q5 – d

 1. To prevent your work being lost 
because of a power cut, you should:

 (a) Save your fi le when you start

 (b) Use CTRL+S or the disk icon to keep 
it updated

 (c) Close your eyes and wish really hard

 (d) Pay your electricity bill

 2. To correct a spelling error a few 
words back, you can:

 (a) Use the mouse to reposition your 
cursor and then fi x it

 (b) See whether Word has fi xed it 
automatically

 (c) Use the cursor keys to move the 
cursor and then fi x it

 (d) Pick it up at the end using the 
spelling checker

 3. If you press the Del key, Word will:
 (a) Delete the character to the left of the 

cursor

 (b) Delete the character to the right of the 
cursor

 (c) Delete whatever text is selected

 (d) Start a new letter to your friend Derek

 4. If you click three times:
 (a) Word will select the word

 (b) Word will select the sentence

 (c) Word will select the paragraph

 (d) You’ll be transported back to your bed 
in a Kansas farmhouse

 5. To make your letter easy to read, it’s 
a good idea to:

 (a) Write it all in capitals

 (b) Use fonts that look like handwriting

 (c) Use a point size of 6-8

 (d) Pick a couple of easy-to-read fonts 
and use them consistently

Brain Training

Your fi rst project has taken you from typing your fi rst word to producing a com-
plete letter. How much did you remember? Try this quiz to fi nd out. There might 
be more than one right answer. 
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